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  Introduction 

We’re glad you will be applying for CSBG funding for Tribes and Tribal Organizations! 

The Community Services Block Grant (CSBG) program provides Native American and 
Alaska Native Tribes and Tribal Organizations with critical funds to address the causes 
and conditions of poverty in their communities. CSBG is a flexible block grant that can 
support a range of services and activities in response to community needs. Funding is 
provided directly to state and federally recognized Tribes and Tribal organizations through 
the U.S. Department of Health and Human Services’ Office of Community Services (OCS). 
For more information, see our Introduction to the Community Services Block Grant (CSBG 
webinar.  

The CSBG Training & Technical Assistance Program for Tribes and Tribal Organizations 
has created the following guide to enable new and renewing CSBG Tribal grantees to use 
the CSBG Tribal Plan & Application Fillable-PDF Tool. The guide provides step-by-step 
directions for completing the fillable-PDF for an easy and seamless application process. 

CSBG funding for each fiscal year is subject to the receipt and approval of all required 
CSBG application materials. 

As you work through the application, please remember that help is available anytime from 
the CSBG Tribal T/TA team at tribalta@luxcg.com or (301) 244-3557. 

Let’s get started! 

  

https://csbgtribalta.com/introduction-to-csbg-webinar/
https://csbgtribalta.com/tools/#1594137466863-95887578-6edd
mailto:tribalta@luxcg.com
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  Fillable-PDF Form Guidance 

Before you begin, please read through all of the following information carefully to ensure 
easy access to the fillable-PDF tools.  

Download the Fillable-PDF Tool onto your computer and save it before you open it 
in Adobe Acrobat to begin working on it! Loss of data will occur if the tool is not 
downloaded, saved, and opened in the Adobe Acrobat program prior to entering 
data. 

Please download and save the CSBG Tribal Plan & Application Fillable-PDF Tool to your 
computer or network drive. This will allow you to save your information and re-open the 
tool later to modify or enter additional information as needed.  

To download the file directly to your computer: 

● Position your cursor on the tool link and click with your right mouse button. (To avoid 
entering “preview” do not activate the link and open the form.) 

● From the menu that pops up, select the “Save target as” option in Internet Explorer or 
the “Save link as” or similar option in another browser. 

● You will then be prompted to choose a location to save the file. 

● Select the location on your own computer or network and click on the “Save” button. 

● Make a note of the location on your computer and the name of the file being saved 
for easy access. 

From there, make sure to open the saved file with the free Adobe Reader program to 
complete the form. Adobe Reader is the only program that will allow you to work with the 
form properly. If you do not already have Adobe Reader, please use the following link to 
install it to your machine for free. 

● To download or update to the most recent free version of Adobe Acrobat Reader, visit 
the Adobe® website. 

After you have downloaded and saved your Fillable-PDF Tool, open the file with Adobe 
Reader and follow the instructions below to successfully complete the application. 

https://csbgtribalta.com/tools/#1594137466863-95887578-6edd
http://get.adobe.com/reader/otherversions
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Complete the Forms 

The Fillable-PDF Tool contains four types of interactive areas: 

● Checkboxes: To check a box, position your cursor over the square and click to mark 
your answer. 

● Text boxes: Click your cursor inside the shaded text box and begin typing. You can 
either type information directly into each field or copy and paste from another 
document.  

● Date boxes: To enter the date position your cursor in the shaded text box and enter 
the date using the following format: mm/dd/yyyy. (Example: 09/01/2020) 

● Signature lines: The FY21 CSBG Tribal Plan & Application Fillable-PDF Tool will 
request several original signatures for the form to be considered complete. While it is 
preferred that digital signatures are used in simplifying the submission process, we 
fully understand that some offices and locations may have limited access to digital 
signature resources. Those who have electronic signature resources may opt to use 
the Electronic Signature Process. Others may prefer to use the Manual Signature 
Process. Please choose the process best suited to your needs in signing your 
documents: 

○ Electronic Signatures: Grantees who choose to use the Adobe Acrobat 
program for digital signatures/certified IDs please use the following directions: 

■ Fully complete all information and save your document before starting 
the digital signature process. To save, choose “File > Save As” on the 
Adobe Reader menu. You will then be prompted to choose a location to 
save the document. 

■ Note: If a change must be made after adding an electronic signature, all 
previous signatures will have to be revalidated by the person who 
originally signed. We recommend keeping a back-up copy just in case 
additional changes have to be made after the document is signed. 
Before adding signatures save the PDF under a new name so that you 
have a completed un-signed copy of the PDF to return to for any 
possible future edits. (Example “CSBG Tribal Plan & Application 
Fillable-PDF Tool – Complete 8.1.20”) 

■ Have the Authorized Tribal Official(s) electronically sign all signature 
lines. To enter an electronic signature, position your cursor in the 
shaded text box. Follow the prompts for a “Certified Signature.” 

https://csbgtribalta.com/tools/#1594137466863-95887578-6edd
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■ All signature lines must be signed for the application to be accepted by 
OCS. Signature lines can be found in the following sections: 

● Section 1, Item 1.5.e.iiii 

● Section 7, Item 7.1.a.iii 

● Section 8, Item 8.1.a.iii  

● Section 8, Item 8.2.b.iii  

● Section 8, Item 8.3.a.iii 

● Section 8, Item 8.4.a.iii 

■ Once all signatures have been added, save the signed PDF and update 
the file name. 

○ Manual Signatures: Grantees who choose to manually sign the required 
sections of the tool, please use the following directions: 

■ Fully complete all information and save your document before printing 
for signatures. To save, choose “File > Save As” on the Adobe Reader 
menu. You will then be prompted to choose a location to save the 
document. 

■ Print all pages of the Fillable-PDF Tool. 

■ Have the Authorized Tribal Official(s) provide original signatures to all 
signature lines. 

■ All signature lines must be signed for the application to be accepted by 
OCS. Signature lines can be found in the following sections: 

● Section 1, Item 1.5.e.iiii 

● Section 7, Item 7.1.a.iii 

● Section 8, Item 8.1.a.iii  

● Section 8, Item 8.2.b.iii  

● Section 8, Item 8.3.a.iii 

● Section 8, Item 8.4.a.iii 

■ Once all signatures have been added, scan the entire signed document 
and save it as a .PDF file.  
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Save PDFs of the Additional Required Materials 

OCS requires that a few additional materials be attached to your completed FY21 CSBG 
Tribal Plan and Application. To follow are the required additional materials: 

● Public Hearing announcements 

● State Recognition documentation (only if citation of State statute was unavailable) 

● Tribal Resolution (only if representing more than one Tribe) 

Note: Returning grantees please do not upload a PDF version of the SF-424M form or a 
copy of the Federal Register into the OLDC System. 

Save these additional materials as PDF files by scanning a document (if not already an 
electronic document) and choosing the File Format "PDF" in the “File > Save As” options. 
Documents should not be encrypted or password-protected. (Do not save scanned 
documents as images.) 

Saving and Uploading Images 

Many CSBG Tribal grantees choose to share pictures of the great work the program is 
doing in their community. These pictures help showcase the CSBG stories in Native 
communities. If you choose to include pictures with your FY21 CSBG Tribal Plan and 
Application, please follow these quick steps: 

● Place all images in a Word Document 

● Save Word doc in the same location as your CSBG Tribal Plan. To save, choose “File 
> Save As”. File Type > PDF 

Consolidate all Final PDFs 

All final materials should be consolidated into a single PDF Portfolio, no larger than 10 MB. 
(This includes the completed and signed Tribal Plan and Application, Additional Required 
Materials, and any Additional Optional Materials.)  

The Tribal T/TA Team is willing to consolidate final materials for you, simply contact us at 
tribalta@luxcg.com. 

● Add electronic/manual signatures before creating a PDF Portfolio. 

mailto:tribalta@luxcg.com
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● Start Acrobat and choose File > Create > PDF Portfolio. 

● Drag files into the Create PDF Portfolio dialog box. Alternatively, choose an option 
from the Add Files menu. You can add a file, folder of files, pages from a scanner, 
web page, or items in the clipboard. 

● Click Create to add the files to the PDF Portfolio. The selected files are added to your 
portfolio and a toolbar along with the thumbnails of the files is displayed in the left 
pane. 

● To rearrange files in a PDF Portfolio, in the navigation pane of a PDF Portfolio, do the 
following: 
-Drag to rearrange files within a folder of the PDF portfolio. 
-Drop files to folders, or folder to another folder provided both are at a same level or 
folder. 

● Click “Save Portfolio As” and rename the portfolio file. 

● Make a note of the location on your computer and the name of the file being saved 
for easy access. 

● Please note: These instructions apply for Adobe Acrobat 2020 and Adobe Acrobat 
DC. 

Submit Your Final Documents 

After completing, signing, and saving your PDF Portfolio, you will be ready to submit them 
in the OLDC System as your official FY21 CSBG Tribal Plan and Application package. 
(Detailed instructions can be found here.) 

 

   OLDC Access  

As you prepare to use the FY21 CSBG Tribal Plan Fillable-PDF tool, please review the 
following instructions and gather the information you will need to complete each item. 

New Accounts & Renewals 

Current CSBG Grant Administrators: Login to the OLDC System and confirm that CSBG 
is listed as one of your programs. If you need CSBG added to an existing OLDC account, 
are requesting a role change, or your contact information needs to be updated please 

https://csbgtribalta.com/tools/#1594137466863-95887578-6edd
https://home.grantsolutions.gov/home/
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complete an OLDC Access Form and submit to Niki Frazier, OCS Senior Records 
Specialist/Project Lead, at nikita.frazier@acf.hhs.gov. 

If you are unable to log in, you can reset your password in OLDC or request this action 
from Niki Frazier, OCS Senior Records Specialist/Project Lead, at 
nikita.frazier@acf.hhs.gov. (For more information on accessing the OLDC System, please 
review our Guide to the OLDC System webinar and materials.) 

New CSBG Administrators (Current Grantees): To gain access to the OLDC System, 
new administrators of current CSBG grantees must complete an OLDC Access Form and 
email it to Niki Frazier, OCS Senior Records Specialist/Project Lead, at 
nikita.frazier@acf.hhs.gov. 

Prospective Grantees: Any Federally or State-recognized Indian Tribe or Tribal 
Organization that is interested in receiving CSBG funds directly must first contact the 
Office Community Services at csbgtribes@acf.hhs.gov to receive specific instructions. 
First-time applicants/prospective grantees will then submit the following before completing 
a CSBG Tribal Plan and Application: 

● Employer Identification Number (EIN) Number; and 

● A signed statement of agreement between the Tribe or Tribal Organization and the 
State confirming the Tribal population and the percentage of Tribal poverty in the 
state. 

 

  

https://csbgtribalta.com/wp-content/uploads/2018/03/OLDC-Access-Form-8.2016.pdf
mailto:nikita.frazier@acf.hhs.gov
mailto:nikita.frazier@acf.hhs.gov
https://csbgtribalta.com/oldc/
https://home.grantsolutions.gov/home/
https://csbgtribalta.com/wp-content/uploads/2018/03/OLDC-Access-Form-8.2016.pdf
mailto:nikita.frazier@acf.hhs.gov
mailto:csbgtribes@acf.hhs.gov
https://csbgtribalta.com/wp-content/uploads/2018/08/Template-State-Concurrence-on-Population-Data-Final-10.1.18.docx
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   CSBG Tribal Plan & Application Materials 

 
SF-424M Form 
(Page 4 of the FY21 CSBG Tribal Plan & Application Fillable-PDF Tool.) 

All grantees must complete an updated SF-424M with their application materials. 
(Including those grantees in the middle of a two-year plan.) 

Returning Grantees: Renewing current grantees will complete the SF-424M Form 
information via the OLDC System. We recommend using Google Chrome for 
increased usability. Please use the following instructions: 

● Log in to the OLDC System. 

● From the enhanced Home page, click the Report Entry Form tab on the left menu. 

● Program Name: Select - Community Services Block Grant 

● Grantee Name: Enter - Name of Tribe or Tribal Organization 

● Report Name: Select - Mandatory SF-424M 

● Report Period: Enter - Current Fiscal Year (10/01/20–09/30/21) 

Select the needed “Action” on the row corresponding with the correct reporting period. 

 
  

https://csbgtribalta.com/wp-content/uploads/2018/03/SF424_Mandatory_1_2-V1.2.pdf
https://home.grantsolutions.gov/home/
http://www.google.com/chrome
https://home.grantsolutions.gov/home/
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● To Initiate Report: Select the plus sign icon  

● To Edit Report: Select the paper and pencil icon  

● To Revise Report: Select the paper icon  

OLDC will then prompt you for additional information. Please use the following 
instructions: 

For a one-year plan (FY21 only): 

● 1.a  Type of Submission: Select - Plan 

● 1.b  Frequency: Select - Annual 

● 1.c  Consolidated Application Plan Request: Ignore section 

● 1.d  Version - Select Initial 

For a new two-year plan (FY21 and FY22): 

● 1.a  Type of Submission: Select - Plan 

● 1.b.  Frequency: Select – Other 

○ Under “Other - Specify” write “Two-year Plan FY 2021 and FY 2022” 

● 1.c  Consolidated Application Plan Request: Ignore section 

● 1.d  Version - Select Initial 

For the second year of a two-year plan (FY21 of a previously approved two-year 
plan): 

● 1.a  Type of Submission: Select - Plan 

● 1.b.  Frequency: Select – Other 

○ Under “Other - Specify” write “Year Two of Two-year Plan” 
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● 1.c  Consolidated Application Plan Request: Ignore section 

● 1.d  Version - Select - Update 

For further instructions on completing the SF-424M form and uploading your 
application materials in OLDC System, please review our Guide to the OLDC System 
webinar recording.  

Prospective Grantees: Follow the instructions provided by your OCS Program 
Specialist after submitting your Employer Identification Number (EIN) Number and 
signed Tribal-State statement of agreement regarding population and poverty 
numbers. 

 

Section 1 - CSBG Tribal Administrative Information/Transmittal Letter 
(Page 4 of the FY21 CSBG Tribal Plan & Application Fillable-PDF Tool) 

Provide the following information in relation to the Tribe or Tribal Organization designated 
to administer CSBG as required in Sections 676 and 677 of the CSBG Act, the Human 
Services Reauthorization Act of 1998 (P.L.105-285), and relevant federal policy guidance.  

The following information should mirror the information provided on the Application for 
Federal Assistance, SF-424M. 

1.1 Name of Tribe or Tribal Organization 

1.2 Fiscal Years covered by the CSBG Tribal Plan 

1.3 Authorized Tribal Official to receive the CSBG Grant Award: Contact 
information for the Authorized Tribal Official (Chairperson/Chief/CEO) who is 
to receive the CSBG Grant Award is as follows: 

1.3.a Name of Authorized Tribal Official  

1.3.b Title of Authorized Tribal Official  

1.3.c Street Address of Authorized Tribal Official 

1.3.d City, State, Zip Code of Authorized Tribal Official 

1.3.e Telephone of Authorized Tribal Official 

https://csbgtribalta.com/oldc/
https://csbgtribalta.com/wp-content/uploads/2020/05/Template-State-Concurrence-on-Population-Data.pdf
https://www.acf.hhs.gov/sites/default/files/ocs/leg_title_iicommunity_services_block_grant_act_10271998.pdf
https://www.govinfo.gov/content/pkg/PLAW-105publ285/html/PLAW-105publ285.htm
https://www.govinfo.gov/content/pkg/PLAW-105publ285/html/PLAW-105publ285.htm
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1.3.f Fax of Authorized Tribal Official 

1.3.g Email of Authorized Tribal Official 

1.3.h Website of Authorized Tribal Official 

1.4 Tribal CSBG Program Contact Person 

1.4.a Name the Tribe or Tribal Organization’s CSBG Tribal Program Contact 
who will administer the CSBG program. (This is a contact person in 
your Tribe or Tribal Organization who will interact with OCS and the 
CSBG T/TA Program throughout the year.) 

1.4.b Title of CSBG Tribal Program Contact 

1.4.c Street address of CSBG Tribal Program Contact 

1.4.d City, State, and Zip Code of SBG Tribal Program Contact 

1.4.e Telephone number of CSBG Tribal Program Contact 

1.4.f Fax number of CSBG Tribal Program Contact 

1.4.g Email address of CSBG Tribal Program Contact 

1.5 Delegation of Authority 

(If appropriate) The delegation of authority made by the Chairperson/Chief/CEO of 
the Tribe or Tribal Organization to another person to certify the plan on their behalf. 
(This individual is allowed to sign all application documents requiring a CEO 
signature). Note: The designation should be updated whenever there is a change 
to the designee. 

1.5.a Name of Authorized Tribal Official 

1.5.b Title of Authorized Tribal Official 

1.5.c Telephone number of Authorized Tribal Official 

1.5.d Email address of Authorized Tribal Official 

1.5.e Chairperson/Chief/CEO Signature 
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Reminder:  

➢ If signature authority is not being delegated, no signature is necessary and “No 
delegation of authority.” can be noted in the signature box.  

➢ If signature is required, wait until the entire CSBG Plan is fully complete before 
adding signature. 

1.5.e.i Name of Tribe or Tribal Organization 

1.5.e.ii Name of Chairperson/Chief/CEO 

1.5.e.iii Title of the Chairperson/Chief/CEO 

1.5.e.iiii Signature of Chairperson/Chief/CEO  

 

Section 2 - CSBG Legislation and Resolution 
(Page 8 of the FY21 CSBG Tribal Plan & Application Fillable PDF-Tool) 

2.1  Tribal Resolution: A Tribal organization representing more than one Indian 
Tribe will be eligible to receive block grant funds on behalf of a particular Tribe only 
if the Tribe has by resolution authorized the organization’s action. Current signed 
and dated copies of the Tribal Resolutions granting authority for a Tribe or Tribal 
Organization to seek and administer CSBG funding must be included in the 
application. 

2.1.a Is the applicant representing more than one Tribe?  

2.2  Federal or State Recognition: All Tribes must provide documentation 
verifying the Federal or State recognition of the Tribe or Tribal organization 
covered by this plan. 

2.2.a Does the Tribe or Tribal Organization have Federal Recognition? 
(Documentation for Tribes with Federal recognition includes providing 
the full name of the Tribe or Tribal Organization as it appears in the 
U.S. Federal Register list of Indian Entities Recognized by and Eligible 
To Receive Services From the United States Bureau of Indian Affairs, 
published on 01/30/2020.) 

2.2.b If not Federally-recognized, does the Tribe or Tribal Organization have 
State Recognition? (Documentation for Tribes without Federal 

https://www.federalregister.gov/documents/2020/01/30/2020-01707/indian-entities-recognized-by-and-eligible-to-receive-services-from-the-united-states-bureau-of
https://www.federalregister.gov/documents/2020/01/30/2020-01707/indian-entities-recognized-by-and-eligible-to-receive-services-from-the-united-states-bureau-of
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Recognition must include proof of their State recognition. This proof 
includes providing a link to proof of State Recognition or citation 
information for the State statute or code acknowledging State 
Recognition.) 

 

Section 3 - CSBG Tribal Plan Mission, Goals, and Objectives 
(Page 10 of the FY21 CSBG Tribal Plan & Application Fillable-PDF Tool) 

3.1  Mission and Responsibility: A description of the mission and responsibilities 
of the agency or department within the Tribe or Tribal Organization that will 
administer the CSBG program. 

3.2 CSBG Goals and Objectives: A description of the CSBG-specific goals and 
objectives for the proposed CSBG funding within the Tribe or Tribal Organization. 

 

Section 4 - Public Hearing Requirements 
(Page 12 of the FY21 CSBG Tribal Plan & Application Fillable-PDF Tool) 

4.1. Evidence of Public Hearing(s): The application must show evidence that the 
Tribe or Tribal Organization made the CSBG Tribal Plan available for public review 
and comment in conjunction with the development of the plan as required under 
Section 676(e)(2) of the CSBG Act. This includes providing the date, time and 
location the actual hearing took place. 

4.1.a. Affirm that the Tribe or Tribal Organization held public hearings that 
were open to the public for review and comment and attach original 
copies of the public hearing announcement(s). 

4.1.b The Tribe or Tribal Organization will list Public Hearings dates and 
locations. 

         
Figure 1. Screenshot of 4.1.b in the FY21 CSBG Tribal Plan Fillable-PDF Tool 
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Section 5 - Use of Funds and Fiscal Controls 
(Page 13 of the FY21 CSBG Tribal Plan & Application Fillable PDF Tool) 

5.1. Planned CSBG Allocation Funds: According to the CSBG Act, not more than 
five (5) percent can be allocated to administrative items, and not less than 95 
percent can be allocated to program funds. The planned allocation in percent for 
Administrative and Program CSBG funding must be provided. If this is a two-year 
plan, the planned allocations for both years must be provided. 

          
Figure 2: Screenshot of 5.1 in the FY21 CSBG Tribal Plan Fillable-PDF Tool  

5.2. Limitation on the Use of Funds: The Tribe or Tribal Organization 
acknowledges and assures that they will abide by the CSBG limitations outlined in 
Section 678F of the CSBG Act as follows: 

 ✓ Affirm that funds will not be used “for the purchase or improvement of land, 
or the purchase, construction, or permanent improvement (other than low-cost 
residential weatherization or other energy-related home repairs) of any 
building or other facility” without an approved federal waiver. (View 
instructions in Section 678F of the CSBG Act for information on waivers for 
construction.) 

✓ Affirm that funds will not be used for any activities associated with voter 
registration or political election activities; 

✓ Affirm that no person shall, on the basis of race, color, national origin, or 
sex be excluded from participation in, be denied the benefits of, or be 
subjected to discrimination under, any program or activity funded in whole or 
in part with CSBG funds. 

 

https://www.acf.hhs.gov/sites/default/files/ocs/leg_title_iicommunity_services_block_grant_act_10271998.pdf
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5.3. Single Audit Review: The date and the period (timeframe) that the most 
recent audit covers. 

               
      Figure 3: Screenshot of 5.3 in the CSBG Tribal Plan PDF Tool 

 

Section 6 - Individual Eligibility Requirements and Target Communities 
(Page 14 of the FY21 CSBG Tribal Plan & Application Fillable PDF Tool) 

6.1. Individual and Community Income Eligibility Requirements: The CSBG 
program requires that services be provided to those who meet specific CSBG 
income guidelines.  

Reminder:  

➢ Under the Coronavirus Aid, Relief, and Economic Security (CARES) Act 
passed in March 2020, Tribes are authorized to revise the CSBG income 
eligibility limit from 125% to 200% of the FPL for CSBG services furnished 
during FY20 and FY21. 

The following information must be provided to verify that funds have been used in 
accordance with the income guidelines. 

6.1.a. Income Eligibility Requirements: A description of any policy and/or 
procedures for income eligibility, such as treatment of income and 
family/household composition. Enter or attach any policies and 
procedures made to ensure income eligibility requirements are made.  

6.1.b. Target Communities: A description of how the organization ensures 
that services target and benefit low-income communities, for those 
services that provide a community-wide benefit. 
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Section 7 - Assurances and Implementation Narratives 
(Page 16 of the FY21 CSBG Tribal Plan & Application Fillable PDF Tool) 

Community Services Block Grant Assurances 

Community Services Block Grant Reauthorization Act of 1998: P.L. 105-285g 

Statement of CSBG Assurances confirm that the Tribe or Tribal Organization will read all 
sections of the CSBG Assurances (summarized in the FY21 CSBG Tribal Plan Fillable-
PDF tool and detailed in Section 676 of the Community Services Block Grant 
Reauthorization Act of 1998: P.L. 105-285) and apply the Authorized Tribal Official’s 
signature to affirm. 

Reminder:  

➢ CSBG Assurances signatures are authorized for up to two years unless 
there is a change in the Authorized Official for the Tribe or Tribal 
Organization. If this section was signed as part of your FY20 CSBG Tribal 
Plan and application materials and there has not been a change in the 
Authorized Official, a new signature is not required. If there has been a 
change in the Authorized Official for the Tribe or Tribal Organization, this 
section must be signed by the new Authorized Official. The new signatures 
will be authorized for up to two years unless there is another change in the 
Authorized Official for the Tribe or Tribal Organization. 

➢ If signatures are required, wait until the entire CSBG Plan is fully complete 
before adding signatures. 

➢ If no signature is required this year, please note “Authorized signature 
provided in FY20.” 

7.1 Statement of CSBG Assurances: As a part of the annual or biannual 
application and plan required by subsection 676 of Community Services Block 
Grant Act, as amended, (412 U.S.C.9901 et seq.) (The Act), the designee of the 
Chief Executive of the State hereby agrees to the Assurances in Section 676 of the 
Act (summarized in the FY21 CSBG Tribal Plan Fillable-PDF tool and detailed in 
Section 676 of the CSBG Act). — 

7.1.a.i Name of Tribe or Tribal Organization 

7.1.a.ii Name of Authorized Tribal Official  

7.1.a.iii Signature of Authorized Tribal Official  

https://www.acf.hhs.gov/sites/default/files/ocs/leg_title_iicommunity_services_block_grant_act_10271998.pdf
https://csbgtribalta.com/tools/#1594137466863-95887578-6edd
https://csbgtribalta.com/tools/#1594137466863-95887578-6edd
https://csbgtribalta.com/tools/#1594137466863-95887578-6edd
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7.2 Implementation of CSBG Assurances: As a part of the annual or biannual 
application and plan required by subsection 676 of Community Services Block 
Grant Act, as amended, (412 U.S.C.9901 et seq.) (The Act), the designee of the 
Chief Executive of the State hereby agrees to the Assurances in Section 676 of the 
Act (summarized in the FY21 CSBG Tribal Plan Fillable-PDF tool and detailed in 
Section 676 of the CSBG Act). — 

7.2.a CSBG Service Delivery System: A description of the service delivery 
system for services provided by or coordinated with CSBG funds. 

7.2.b CSBG Geographical Areas and Individuals: Information about areas 
and categories of individuals to be served with CSBG funds. 

7.2.c Method & Criteria for Distribution of Funds: A description of the 
criteria and method used for the distribution of CSBG funds. 

7.2.d Purpose of Funds: Tribes are required to implement at least one of the 
programmatic assurances as stated in Section 676(b) of the CSBG Act 
of the CSBG Act. Provide a description of the activities to be supported 
with CSBG funds that will address at least one of the following areas 
(for any section that is not applicable, please type N/A): 

7.2.d.i. Assist low-income families and individuals in removing 
obstacles that block the achievement of self-sufficiency; secure 
and retain meaningful employment; attain adequate literacy and 
education; make better use of available income; obtain and 
maintain adequate housing; obtain emergency assistance; and 
achieve greater participation in the affairs of the communities. 

7.2.d.ii. Address the needs of youth in low-income communities 
through youth development programs, such as programs for the 
establishment of violence-free zones and after- school childcare 
programs. 

7.2.d.iii. Make more effective use of, and to coordinate with, other 
programs related to the purposes of the CSBG Act (including 
welfare reform efforts). 

7.2.e Linkages: A description of how linkages will be developed to fill 
identified gaps in services, through the provision of information, 
referrals, case management, and follow up consultations. 

7.2.f Coordination with Other Public and Private Resources: A description 
of how funds made available will be coordinated with other public and 
private resources. 

https://csbgtribalta.com/tools/#1594137466863-95887578-6edd
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7.2.g Innovative Community and Neighborhood-based Initiatives: A 
description of how funds will be used to support innovative community 
and neighborhood-based initiatives related to the purposes of the 
CSBG, which may include fatherhood initiatives and other initiatives 
with the goal of strengthening families and encouraging effective 
parenting. 

7.2.h Plan for the provision of emergency services: A description of how 
the provision of emergency services will be provided with CSBG funds. 
(Optional Description) 

7.2.i Performance Management and Accountability System: A description 
of the outcome measures to be used to measure the performance 
CSBG specific goals and objectives in promoting self- sufficiency, family 
stability, and community revitalization. (Optional Description) 

 

Section 8 - Federal Certifications 
(Page 32 of the FY21 CSBG Tribal Plan & Application Fillable PDF Tool) 

Each of the four following certifications needs to be reviewed and signed by the 
Chairperson / Chief / CEO. Certifications must show signatures signed by the Chairperson 
/ Chief /CEO. If the Chairperson / Chief / CEO has delegated this responsibility, a written 
confirmation of such a delegation signed by the Chairperson / Chief / CEO must be 
indicated in the Transmittal Letter. If advance scheduling is required to obtain the 
Chairperson / Chief / CEO signatures, please schedule well in advance of the application 
deadline. 

Reminder:  

➢ Federal Certification signatures are authorized for up to two years unless there 
is a change in the Authorized Official for the Tribe or Tribal Organization. If this 
section was signed as part of your FY20 CSBG Tribal Plan and application 
materials and there has not been a change in the Authorized Official, a new 
signature is not required. If there has been a change in the Authorized Official 
for the Tribe or Tribal Organization, this section must be signed by the new 
Authorized Official. The new signatures will be authorized for up to two years 
unless there is another change in the Authorized Official for the Tribe or Tribal 
Organization. 

➢ If signatures are required, wait until the entire CSBG Plan is fully complete 
before adding signatures. 
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➢ If no signature is required this year, please note “Authorized signature 
provided in FY20.”   

8.1 Certification Regarding Lobbying 

Review complete Certification Regarding Lobbying. 

8.1.a Authorized Tribal Official Signature: After reviewing certification, insert 
authorized Tribal official signature  

 8.1.a.i Name of Tribe or Tribal Organization 

8.1.a.ii Name of Authorized Tribal Official 

8.1.a.iii Signature of Authorized Tribal Official  

8.2. Certification Regarding Drug-Free Workplace Requirements 

Review complete Certification Regarding Drug-Free Workplace Requirements. 

8.2.a Authorized Tribal Official Signature: After reviewing certification, insert 
authorized Tribal official signature  

 8.2.a.i Name of Tribe or Tribal Organization 

8.2.a.ii Name of Authorized Tribal Official 

8.2.a.iii Signature of Authorized Tribal Official  

8.3 Certification Regarding Debarment, Suspension, and Other 
Responsibility Matters 

Review complete Certification Regarding Debarment, Suspension, and Other 
Responsibility Matters. 

8.3.a Authorized Tribal Official Signature: After reviewing certification, insert 
authorized Tribal official signature  

 8.3.a.i Name of Tribe or Tribal Organization 

8.3.a.ii Name of Authorized Tribal Official 

https://csbgtribalta.com/wp-content/uploads/2018/04/CERTIFICATION-REGARDING-LOBBYING.pdf
https://csbgtribalta.com/wp-content/uploads/2018/04/CERTIFICATION-REGARDING-DRUG.pdf
https://csbgtribalta.com/wp-content/uploads/2018/04/CERTIFICATION-REGARDING-DEBARMENT.pdf
https://csbgtribalta.com/wp-content/uploads/2018/04/CERTIFICATION-REGARDING-DEBARMENT.pdf
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8.3.a.iii Signature of Authorized Tribal Official   

8.4 Certification Regarding Environmental Tobacco Smoke 

Review complete Certification Regarding Environmental Tobacco Smoke. 

8.4.a Authorized Tribal Official Signature: After reviewing certification, insert 
authorized Tribal official signature  

 8.4.a.i Name of Tribe or Tribal Organization 

8.4.a.ii Name of Authorized Tribal Official 

8.4.a.iii Signature of Authorized Tribal Official  

 

Section 9 - Annual Report 
(Page 46 of the FY21 CSBG Tribal Plan & Application Fillable PDF Tool) 

Annual Reports are due on December 30 of each year. All renewing grantees must submit 
an Annual Report each year via the OLDC System (This includes grantees with 
previously-approved two-year CSBG Tribal Plans).  

The Annual Report is a narrative description of how the grantee met its CSBG goals and 
objectives and provides information on the types of projects supported with CSBG funding 
awarded in the previous fiscal year. 

Note: A fillable-PDF tool for the FY20 CSBG Annual Report will be available on the CSBG 
Tribal Online Resource Center, Tools & Templates page in the Fall.  

9.1. Mandatory Annual Report: The Tribe or Tribal Organization affirms that it will 
complete a FY20 CSBG Annual Report by December 30, 2020. 

  

https://csbgtribalta.com/wp-content/uploads/2018/04/CERTIFICATION-REGARDING-ENVIRONMENTAL-TOBACCO-SMOKE.pdf
https://home.grantsolutions.gov/home/
https://csbgtribalta.com/tools/
https://csbgtribalta.com/tools/
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   Reviewing & Saving Completed Fillable-PDF Tool 

Review all sections of the FY21 CSBG Tribal Plan & Application Fillable-PDF Tool to be 
sure that all fields are complete. 

Fully complete all information and save your document before starting the signature 
process. To save, choose “File > Save As” on the Adobe Reader menu. You will then be 
prompted to choose a location to save the document. 

 

   Adding Signatures 

The FY21 CSBG Tribal Plan & Application Fillable-PDF Tool will request several original 
signatures for the tool to be considered complete. While it is preferred that electronic 
signatures are used in simplifying the reporting process, we fully understand that some 
offices and locations may have limited access to digital signature resources. Those who 
have digital signature resources may opt to use the Electronic Signature Process. Others 
may prefer to use the Manual Signature Process. Please choose the process best suited 
to your needs in signing your documents. 

All signature lines must be signed for the application to be accepted by OCS. Signature 
lines can be found in the following sections: 

● Section 1, Item 1.5.e.iiii 

● Section 7, Item 7.1.a.iii 

● Section 8, Item 8.1.a.iii  

● Section 8, Item 8.2.b.iii  

● Section 8, Item 8.3.a.iii 

● Section 8, Item 8.4.a.iii 

Detailed instructions for adding signatures to the FY21 CSBG Tribal Plan & Application 
Fillable-PDF can be found here. 
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   Submitting the CSBG Tribal Plan & Application Materials to OCS 

Renewing applicants: Please remember that renewing grantees in the middle of an 
approved two-year plan must submit an updated SF-424M form and a CSBG Annual 
Report each year. They do not, however, need to resubmit their CSBG Tribal Plan. 

● Save all documents for reference and future administrators. 

● Sign into the OLDC System. (Detailed instructions on using the OLDC System can be 
found in our Guide to the OLDC System webinar recording.) 

● Fill out the SF-424M electronic form, if you haven’t already.  

● Upload the following PDFs into the OLDC system: your completed and signed Tribal 
Plan and Application, and Additional Required Materials. (Detailed instructions on 
using the OLDC System, can be found in our Guide to the OLDC System webinar 
recording.) 

First-time applicants: Follow the instructions provided by your OCS Program Specialist 
after submitting your EIN and Tribal-State agreement letter. 

 

 

   Help is Available Anytime! 

Remember that help is always available anytime from the CSBG Tribal T/TA Program 
team at tribalta@luxcg.com or (301) 244-3557. 

https://home.grantsolutions.gov/home/
https://csbgtribalta.com/oldc/
https://csbgtribalta.com/oldc/
mailto:tribalta@luxcg.com
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